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BAB II 

TINJAUAN PUSTAKA 

 

2.1 Umum 

Berhasil atau tidaknya mengelola suatu proyek konstruksi, bergantung kepada 

orang-orang yang mengelolanya. Proyek yang gagal dapat diartikan sebagai proyek yang 

tidak tercapainya sasaran yang direncanakan dan penyebab utamanya adalah terdapat 

beberapa aktivitas yang tidak tercapai dalam keseluruhan aktivitas yang sudah 

direncanakan. Menjadikan segala sesuatu nya terjadi untuk mencapai suksesnya 

pembangunan sebuah proyek adalah nama lain untuk “manajemen” (Nugrahadkk 1985:7). 

Sedangkan menurut H. Koontz  (1982) dalam Imam Soeharto (1997:17) memberikan 

definisi sebagai berikut : 

“ Manajemen adalah proses merencanakan, mengorganisir, memimpin dan 

mengendalikan kegiatan anggota serta sumber daya yang lain untuk mencapai 

sasaran organisasi (perusahaan) yang telah ditentukan “ 

 Kegiatan proyek dapat diartikan sebagai suatu kegiatan sementara yang 

berlangsung dalam jangka waktu terbatas, dengan alokasi sumberdaya tertentu dan 

dimaksudkan untuk melaksanakan tugas yang sasarannya telah digariskan dengan jelas 

(Soeharto, 1971:1).Tugas tersebut dapat berupa membangun pabrik, membuat produk baru 

atau melakukan penelitian atau pengembangan. Dari pengertian tersebut terlihat bahwa 

pokok proyek adalah : 

 Memiliki tujuan yang khusus, produk akhir atau hasil kerja 

 Jumlah biaya, sasaran jadwal serta criteria mutu dalam mencapai proses tujuan 

diatas telah ditentukan 

 Bersifat sementara, dalam arti umurnya dibatasi oleh selesainya tugas, titik awal 

dan akhir ditentukan dengan jelas 

 Non-rutin, tidak berulang-ulang, jenis dan intensitas kegiatan berubah sepanjang 

proyek berlangsung 

Dalam proses mencapai tujuan, telah ditentukan batasan-batasannya yaitu besar 

biaya yang di alokasikan, jadwal serta mutu yang harus dipenuhi. Ketiga batasan tersebut 
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disebut tiga kendala (triple constraint).Ketiga batasan tersebut bersifat tarik-

menarik.Artinya, jika ingin mempercepat waktu maka akan berpengaruh pada biaya. 

Sebaliknya bila ingin memperkecil biaya maka akan menurunkan mutu. 

 

2.2 Penjadwalan 

Penjadwalan merupakan fase menterjemah suatu perencanaan kedalam suatu 

diagram-diagram yang sesuai dengan skala waktu. Penjadwalan menentukan kapan 

aktivitas-aktivitas itu dimulai, ditunda dan diselesaikan, sehingga pembiayaan dan 

pemakaian sumber daya akan disesuaikan dengan waktu menurut kebutuhan yang telah 

ditentukan (Nugraha, dkk 1986:25) 

 

2.2.1 Bagan Balok (bar chart method) 

Bagan balok adalah bagan batang yang menggambarkan pekerjaan proyek 

berdasarkan kalender, setiap batang mewakili satu pekerjaan proyek, Bagan ini bertujuan 

untuk mengidentifikasi pekerjaan terhadap unsur waktu dari urutan waktu (starting time), 

waktu penyelesaian(solution time) dan saat pelaporan(reporting). Namun Bagan balok(bar 

chart method)ini memiliki kendala-kendala keterbatasan dalam penggunaanya, seperti : 

 Tidak menunjukan secara spesifik hubungan ketergantungan antara satu kegiatan 

dengan yang lain, sehingga sulit untuk mengetahui dampak yang diakibatkan oleh 

keterlambatan suatu kegiatan terhadap jadwal keseluruhan proyek 

 Sukar mengadakan perbaikan atau pembaharuan(updating), karena umumnya harus 

dilakukan dengan membuat bagan balok baru, padahal tanpa adanya pembaharuan 

segera menjadi kuno dan akan menurun daya gunanya 

 Untuk proyek berukuran sedang dan besar, terutama yang bersifat kompleks, 

penggunaan bagan balok akan menghadapi kesulitan menyusun sedemikian besar 

jumlah kegiatan yang mencapai puluhan ribu dan memiliki keterkaitan sendiri 

diantara mereka, sehingga mengurangi kemampuan penyajian secarasi stematis 

(Imam Soeharto, Manajemen Proyek:181) 
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Gambar 2.1.bagan balok 

2.2.2 Jaringan Kerja(Network Analysis) 

Dari segi penyusunan jadwal, jaringan kerja  dipandang sebagai suatu langkah 

penyempurnaan metode BaganBalok(bar chart method), karena dapat member i jawaban 

atas pertanyaan-pertanyaan yang belum terpecahkan oleh metode tersebut, seperti : 

1 Berapa lama perkiraan kurun waktu pelaksanaan proyek  

2 Kegiatan-kegiatan mana yang bersifat kritis dalam hubunganya dengan 

penyelesaian  proyek 

3 Bila terjadi keterlambatan dalam pelaksanaan kegiatan tertentu, bagaimana 

pengaruhnya terhadap sasarana dwal penyelesaian proyek secara menyeluruh 

Disamping itu, jaringan kerja berguna untuk : 

 Menyusun kegiatan proyek yang memiliki komponen yang berjumlah besar dengan 

hubungan ketergantungan yang kompleks 

 Membuat jadwal proyek yang paling ekonomis 

 Mengusahakan fluktuasi minimal penggunaansumberdaya (Imam Soeharto, 

Manajemen Proyek;181) 
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Diantara berbagai versi analitis jaringan kerja yang sangat luas pemakaianya adalah 

metode jalur kritis(critical path method-CPM), teknik evaluasi dan review proyek(project 

evaluation and review technique-PERT)dan metode preseden diagram(precedence diagram 

method-PDM). 

Jaringan kerja merupakan metode yang dianggap mampu menyuguhkan teknik dasar dalam 

menentukan urutan dan kurun waktu kegiatan unsure proyek dan pada giliran selanjutnya 

dapat dipakai memperkirakan waktu penyelesaian proyek secara keseluruhan. 

 

2.2.3 Metode Jalur Kritis(critical path method-CPM) 

Pada metode jaringan kerja dikenal adanya jalur kritis, yaitu jalur yang memiliki 

rangkaian komponen-komponen kegiatan, dengan total jumlah waktu terlama dan 

menunjukan kurun waktu penyelesaian proyek  yang tercepat. Jadi jalur kritis terdiri dari 

rangkaian kegiatan kritis, dimulai dari kegiatan pertama sampai pada kegiatan terakhir 

proyek.Makna jalur kritis penting bagi pelaksanaan proyek, karena pada jalur ini terletak 

kegiatan-kegiatan yang bila pelaksanaanyaterlamabat, akan menyebabkan keterlambatan 

proyek secarakeseluruhan. Kadang-kadang dijumpai lebih dari satu jalur kritis dalam 

jaringan kerja. 

 Jalur ini memerlukan perhatian maksimal dari pengelola proyek, terutama pada 

periode perencanaan dan implementasi pekerjaan/ kegiatan yang bersangkutan, misalnya 

diberikan prioritas utama dalam sumberdaya yang dapat berupa tenagakerja, peralatan atau 

penyedia.Pengalaman menunjukan bahwa kegiatan-kegiatan kritis dari suatu proyek 

umumnya kurang dari 20% total pekerjaan, sehingga memberikan perhatian lebih 

kepadanya dianggap tidak akan mengganggu kegiatan yang lain bila telah direncanakan 

dengan sebaik-baiknya (Soeharto, 1997;207). 

 Dalam proses identifikasi jalur kritis, dikenal beberapa terminology dan rumus-

rumus perhitungan sebagai berikut : 

 TE = E 

 Waktu paling awal peristiwa(node event)dapat terjadi(earliest time of occurance), 

yang berarti waktu paling awal suatu kegiatan yang berasal dari mode tersebut dapat 
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dimulai, karena menurut aturan dasar jaringan kerja, suatu kegiatan harus dapat dimulai 

bila kegiatan terdahulu telah selesai. 

 TL = L 

 Waktu paling akhir peristiwa boleh terjadi(latest allowable event occurance 

time), yang berarti waktu paling lambat yang masih diperbolehkan bagi suatu peristiwa 

terjadi. 

 ES 

 Waktu mulai paling awal suatu pekerjaan(earliest start time).Bila waktu 

kegiatan dinyatakan atau berlangsung dalam jam, maka waktu itu adalah am paling awal 

kegiatan dimulai. 

 EF 

 Waktu selesai paling awal suatu kegiatan( earliest finish time). Bila hanya ada 

satu kegiatan terdahulu, maka EF suatu kegiatan terdahulu merupakan ES kegiatan 

selanjutnya 

 LS 

 Waktu paling akhir kegiatan boleh dimulai(latest allowable start time), yaitu 

paling akhir kegiatan boleh dimulai tanpa memperlambat proyek secara keseluruhan. 

 LF 

 Waktu paling akhir kegiatan boleh selesai(latest allowable finish time), tanpa 

memperlambat waktu penyelesaian proyek. 

 

 D 

 Adalah kurun waktu kegiatan.Umumnya dengan satuan hari, minggu, bulan 

dan lain-lain (Imam Soeharto, Manajemen Proyek;197) 
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 Pada perencanaan dan penyusunan jadwal proyek, arti penting dari float total 

adalah menunjukan jumlah waktu yang diperkenankan suatu kegiatan boleh ditunda, tanpa 

mempengaruhi jadwal penyelesaian proyek secara keseluruhan. Jumlah waktu tersebut 

sama dengan waktu yang di dapat bila semua kegiatan terdahulu dimulai seawal mungkin, 

sedangkan semua kegiatan berikutnya dimulai selambat mungkin. Float total ini dimiliki 

bersama oleh semua kegiatan yang ada pada jalur yang bersangkutan. 

 

2.2.4 Diagram Preseden (Presedence Diagram Method) 

 Metode preseden diagram adalah aringan kerja yag termasuk klarifkasi AON 

(actifity on node), disini kegiatan dituliskan dalam node yang umumnya berbentuk segi 

empat, sedangkan anak panah hanya sebagai petunjuk hubungan antara kegiatan-kegiatan 

yang bersangkutan. 

 Kegiatan dan peristiwa pada preseden diagram ditulis dalam node segi empat. 

Dalam PDM kotak tersebut menandai suatu kegiatan, dengan demikian harus dicantumkan 

identitas kegiatan dan kurun waktunya. Adapun peristiwa merupakan ujung-ujung 

kegiatan. Setiap node mempunyai dua peristiwa, yaitu peristiwa awal dan akhir. Ruangan 

dalam node dibagi menjadi kompartemen-kompartemen kecil yang berisi keterangan 

spesifik dari kegiatan dan peristiwa yang bersangkutan dan dinamakan atribut. Beberapa 

atribut yang sering dicantumkan diantaranya adalah kurun waktu kegiatan, mulai dan 

selesainya kegiatan ( ES, LS, EF, LF, dan lain-lain) 

 Dalam metode preseden diagram, sebuah kegiatan dapat dikerjakan tanpa 

harus menunggu kegiatan pendahulunya selesai 100%, hal ini dimungkinkan terjadi 

dengan overlapping (tumpang tindih). Untuk kegiatan yang selain tumpang tindih, 

penggambaran network PDM lebih sederhana dibandingkan dengan metode jalur kritis 

yang harus dibuat bertingkat. Berikut ini gambar dan keterangan gambar PDM : 
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Gambar 2.2 contoh blok diagram preseden 

Dimana : 

 ES   = Mulai paling awal (earliest start)  

 EF   = Berakhir paling awal (earliest finish)  

 LS   = Mulai paling lambat (latest start)  

 LF   = Berakhir paling lambat (latest finish)  

 ID   = Identifikasi 

 Label  = Nama aktivitas 

 Durasi  = Waktu aktivitas 

 

 Diagram preseden dapat diperoleh degan mudah dengan mengubah dari 

diagram panah dan menempatkan aktivitas-aktivitas ke dalam node atau kotak, kemudian 

baru digambarkan hubungan logikanya dengan garis-garis penghubung yang arah 

membacanya selalu dari kiri ke kanan dan tidak boleh kembai ke kiri lagi. Penggunaan 

anak panah juga diperkenankan tetapi hanya berfungsi sebagai penghubung saja. Aktivitas 

dummy tidak diperlukan lagi pada diagram preseden ini sehingga terlihat lebih rapi. 

 Pada diagram preseden dapat digambarkan adanya 4 hubungan aktivitas, yaitu 

hubungan awal-awal (start to start), awal-akhir (start to finish), akhir-awal (finish to start), 

akhir-akhir (finish to finish). Dimana pengertianya adalah sebagai berikut : 

 

 

 

ES EF

ID Durasi

LS LF

Label

ES ID EF

LS Durasi LF

Label
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 Hubungan awal-awal (start to start) 

Biasanya dinyatakan dengan SS, dimana mulainya aktivitas B tergantung pada 

dimulainya aktivitas A. 

 

 

 

 

 

 

Gambar 2.3 awal-awal (SS) 

 

 Hubungan  akhir-awal (finish to start) 

Pengeturan relasi yang paling sederhana dan sering dijumpai dalam praktek, 

dimana sebuah aktivitas harus selesai dulu seratus persen sebelum pekerjaan 

berikutnya dimulai, biasanya dinyatakan dengan FS. 

 

 

 

Gambar 2.4 akhir-awal (FS) 

 

 Hubungan  akhir-akhir (finish to finish) 

Biasanya dinyatakan dengan FF, dimana hubungan ini menggambarkan selesainya 

aktivitas A menentukan kapan selesainya aktivitas B. 

 

 

 

 

 

 

 

Gambar 2.5  akhir-akhir (FF) 

A B 

A 

B 

A 

B 
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 Hubungan antar aktivitas dapat dibatasi dengan waktu, misalnya : 

FS + 6 : dimana kegiatan B dilaksanakan setelah kegiatan A selesai 6 hari 

 

 

 

6 hari 

Gambar 2.6  Hubungan FS + 6 

FS – 6 : dimana kegiatan B dilaksanakan 6 hari sebelum kegiatan A selesai 

 

6 hari 

 

 

Gambar 2.7  Hubungan FS – 6 

Ciri-ciri diagram preseden adalah sebagai berikut : 

 Aktivitas-aktivitas tidak dinyatakan sebagai anak panah (arrow) lagi, melainkan 

dimasukan node, berupa lingkaran atau kotak 

 Anak panah atau garis penghubung tidak mempunyai durasi, sehingga diagram 

preseden tidak diperlukan aktivitas dummy lagi, sehingga diagram menjadi lebih 

bersih. (Paulus Nugraha, dan kawan-kawan. Manajemen Proyek Konstruksi 2 : 54) 

 

2.3 Unsur-unsur Biaya 

Imam soeharto (1991 : 131) menyatakan bahwa suatu perkiraan biaya akan 

lengkap bila mengandung unsur-unsur berikut : 

1. Biaya pembelian material dan peralatan 

A 

B 

A 

B 
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Material dan peralatan ini terdiri dari material curan, peralatan utama yang 

akan terpasang sebagai bagian fisik bangunan dan lain-lain, yang diperlukan 

dalam proses palaksanaan proyek seperti fasilitas sementara dan lain-lain 

2. Biaya penyewaan atau pembelian material konstruksi 

Disamping peralatan pada butir 1, terdapat juga peralatan yang 

dipergunakan sebagai sarana bantu konstruksi dan tidak akan menjadi 

bagian permanen dari bangunan, contoh ini adalah truck, crane, forklift, 

grader, scraper, dan lain-lain 

3. Upah tenaga kerja 

Hal ini terdiri dari tenaga kerja kantor pusat yang sebagian besar terdiri dari 

ahli bidang engineering dan bidang konstruksi plus penyedia lapangan. 

Mengingat porsi tenaga kerja dapat mencapai 25-35% dari total biaya 

proyek, maka mengkaji masalah ini sedalam-dalamnya amat penting 

didalam memperkirakan biaya proyek 

4. Biaya sub-kontrak 

Pekerjaan sub-kontrak umumnya merupakan paket kerja yang terdiri dari 

jasa dan material yang disediakan oleh sub-kontraktor, dan belum termasuk 

dalam klasifikasi butir 1,2 dan 3 

5. Biaya transportasi 

Termasuk seluruh biaya transportasi material, peralatan tenaga kerja yang 

berkaitan dengan penyelenggaraan proyek 

6. Overhead dan daministrasi 

Komponen ini meliputi pengeluaran operasi perusahaan yang dibebankan 

kepada proyek (menyewa kantor, membayar listrik, telepon, biaya 

pemasaran) dan pengeluaran untuk pajak, asuransi, royalty, uang jaminan 

dan lain-lain 

7. Fee/laba kontingensi 

Kontingensi dimaksudkan untuk menutupi hal-hal yang belum pasti 
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Sedangakan Paulus Nugraha, dkk (1985 : 65) menyatakan bahwa biaya proyek 

konstruksi dapat dibagi sebagai berikut : 

1. Biaya langsung (direct cost), yaiu biaya yang secara langsung berhubungan 

dengan konstruksi, tetapi harus ada dan tidak dilepaskan dari proyek 

tersebut 

Contoh : 

 Bahan/material 

 Upah buruh/labor/man power 

 Biaya peralatan/equipments 

2. Biaya tak langsung (indirect cost), yaitu biaya yang tidak secara langsung 

berhubungan dengan konstruksi, tetapi harus ada dan tidak dilepaskan dari 

proyek tersebut 

Contoh : 

 Overhead 

 Biaya tak terduga/kontingensi 

 Keuntungan/profit 

  

2.4 Tenaga kerja 

 Untuk menyelenggarakan proyek, salah satu sumberdaya yang menjadi 

factor penentu keberhasilanya adalah tenaga kerja. Seperti telah disebutkan bahwa 

jenis dan intensitas kegiatan proyek berubah cepat sepanjang siklusnya, sehingga 

penyediaan jumlah tenaga kerja, jenis keterampilan dan keahlian harus mengikuti 

tuntutan perubahan kegiatan yang sedang berlangsung. 

 Untuk merencanakan tenaga kerja proyek yang realistis perlu diperhatikan 

bermacam-macam factor, diantaranya yang terpenting adalah sebagai berikut : 

1. Produktivitas tenaga kerja 

2. Tenaga kerja periode puncak 

3. Jumah tenaga kerja kantor pusat 

4. Perkiraan jumlah tenaga kerja konstruksi di lapangan 

5. Meratakan umlah tenaga kerja guna mencegah gejolak (fluctuation) 

tajam (Imam soeharto, Manaemen Proyek :162) 
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2.5 Jadwal dan Sumber Daya 

Sebelumnya telah dibahas jalur kritis dalam suatu jaringan kerja yang 

menunjukan waktu paling cepat penyelesaian proyek dan float yang 

mengidentifikasi kapan suatu kegiatan paling lambat boleh dimulai tanpa 

mengganggu jadwal proyek, seringkali timbul pertanyaa apakah kurun waktu 

tersebut sudah optimal, atau dengan kalimat lain, dapatkah kurun waktu 

penyelesaian proyek dipersingkat dengan menambah biaya atau sumber daya lain, 

dalam batas-batas yang masih dianggap ekonomis. 

2.5.1 Jadwal yang Ekonomis 

metode jaringan kerja CPM dapat digunakan untuk menganalisis masalah 

tersebut, yang dengan memperkirakan : 

 Jadwal yang ekonomis bagi suatu proyek, yang didasarkan atas biaya 

langsung untuk mempersingkat waktu penyelesaian komponen-

komponenya 

 Jadwal yang optimal dengan mengadakan analisis hubungan antara waktu 

terhadap biaya. Dimulai dari suatu kegiatan, kemudian dikembangkan bagi 

semua kegiatan-kegiatan yang merupakan suatu proyek. 

 

2.5.2 Mempersingkat Waktu Penyelesaian 

Proses mempercepat kurun waktu disebut crash program. Di dalam 

menganalisis proses tersebut digunakan asumsi sebagai berikut : 

 Jumlah sumber daya yang tersedia tidak merupakan kendala, ini berarti 

dalam menganalisis program mempersingkat waktu, alternative yang dipilih 

tidak dibatasi oleh terbatasnya sumber daya 

 Bila diinginkan waktu penyelesaian pekerjaan lebih cepat dengan lingkup 

yang sama, maka keperluan sumber daya akan menambah. Sumber daya ini 

dapat berupa tenaga kerja, material, peralatan atau bentuk lain yang dapat 

dinyatakan dalam sejumlah cara ( Imam Soeharto ) 
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2.5.3 Hubungan Waktu dan Biaya 

Biaya (cost) merupakan salah satu aspek yang penting dalam manajemen, 

dimana biaya yang mungkin timbul harus dikendalikan seminimum mungkin. 

Pengendalian biaya harus memperhatikan factor waktu, karena terdapat hubungan 

yang erat antara waktu penyelesaian proyek dengan biaya-biaya proyek yang 

bersangkutan atau aktivitas penfukungnya. 

Sering kali penyelesaian suatu proyek harus diselesaikan dengan mengebut, 

hal ini di karenakan proyek tersebut telah mengalami keterlambatan dari waktu 

normalnya. Dalam hal ini pimpinan proyek (project manager) dihadapkan kepada 

masalah bagaimana mempercepat penyelesaian proyek dengan biaya yang minimal 

untuk mengejar keterlambatan dari proyek tersebut. Oleh karena itu perlu dipelajari 

terlebih dahulu hubungan antara waktu dengan biaya (time cost relationship).  

2.6 Microsoft Project  

Microsoft Project adalah sebuah aplikasi untuk mengelola suatu proyek. 

Microsoft project merupakan sistem perencanaaan yang dapat membantu dalam 

menyusun penjadwalan (scheduling) suatu proyek atau rangkaian pekerjaan. 

Microsoft project juga mampu membantu melakukan pencatatan dan pemantauan 

terhadap penggunaan sumber daya (resource), baik yang berupa sumber daya 

manusia maupun yang berupa peralatan. Yang dikerjakan oleh microsoft project 

antara lain: mencatat kebutuhan tenaga kerja pada setiap sektor, mencatat jam kerja 

para pegawai, jam lembur dan menghitung pengeluaran sehubungan dengan ongkos 

tenaga kerja, memasukkan biaya tetap, menghitung total biaya proyek, serta 

membantu mengontrol penggunaan tenaga kerja pada beberapa pekerjaan untuk 

menghindari overallocation (kelebihan beban pada penggunaan tanga kerja) (Adi 

Kusrianto, 2008). 

Microsoft Project 2007 memiliki beberapa macam tampilan layar, namun 

sebagai default setiap kali membuka file baru, yang akan ditampilkan adalah Gantt 

ChartView. 
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Gambar 2.8 Tampilan layar Grant Chart View 

Dalam Microsoft Project ada beberapa istilah khusus, antara lain: 

1. Task 

Task adalah salah satu bentuk lembar kerja dalam Microsoft Project yang berisi 

rincian pekerjaan sebuah proyek. 

2. Duration 

Duration merupakan jangka waktu yang diperlukan untuk menyelesaikan suatu 

pekerjaan. 

3. Start 

Start merupakan nilai tanggal dimulainya suatu pekerjaan. 

4. Finish 

Dalam Microsoft Project tanggal akhir pekerjaan disebut finish, yang akan 

diisi secara otomatis dari perhitungan tanggal mulai (start) ditambah lama 

pekerjaan (duration). 

5. Predecessor 

Predecessor merupakan hubungan keterkaitan antara satu pekerjaan dengan 

pekerjaan lain. Dalam Microsoft Project mengenal 4 macam hubungan antar 

pekerjaan, yaitu: 

1. FS (Finish to Start) 

Suatu pekerjaan baru boleh dimulai jika pekerjaan yang lain selesai. 
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2. FF (Finish to Start) 

Suatu pekerjaan harus selesai bersamaan dengan selesainya 

pekerjaan lain. 

 

3. SS (Start to Start) 

Suatu pekerjaan harus simulai bersamaan dengan pekerjaan lain. 

 

4. SF (Start to Finish) 

Suatu pekerjaan baru boleh diakhiri jika pekerjaan lain dimulai. 

 

6. Resources 

Sumber daya, baik sumber daya manusia maupun material dalam 

Microsoft Project disebut dengan resources. 

7. Baseline 

Baseline adalah suatu rencana baik jadwal maupun biaya yang telah 

disetujui dan ditetapkan. 

8. Gantt Chart 

Gantt chart merupakan salah satu bentuk tampilan dari Microsoft 

Project yang berupa batang-batang horisontal yang menggambarkan 

masing-masing pekerjaan beserta durasinya. 

 

 

2.6.1 Tracking 

Tracking adalah proses pelacakan jadwal yaitu membandingkan antara jadwal 

rencana dengan progress actual dari pekerjaan yang telah dilaksanakan setiap periode 

waktu. Proses tracking dilakukan pada jadwal yang dibuat dengan menggunakan bantuan 

software ( misalnya : MS.Project, Primavera Project Planner, dll ) 

Perhitungan perbedaan antara jadwal rencana dengan progress actual pada tracking 

berdasarkan bobot durasi pekerjaan, sementara pada kurva S berdasarkan bobot biaya 
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pekerjaan. Karena perhitungan pada tracking berdasarkan durasi pekerjaan, maka pengaruh 

keterlambatan/percepatan pelaksanaan akan dapat diperhitungkan terhadap total durasi 

pekerjaan ( saifoemk.lecture.ub.ac.id ) 

Untuk mengetahui perubahan waktu pelak-sanaan akibat keterlambatan/percepatan 

pelaksanaan terhadap biaya pekerjaan, terlebih dahulu harus diinputkan Resource yang 

terdiri dari Work dan Material termasuk Standar Rate nya pada tiap-tiap pekerjaan 

sehingga biaya tiap pekerjaan dapat dihitung secara otomatis oleh MS Project. ( 

saifoemk.lecture.ub.ac.id ) 

Sebelum melakukan Tracking,langkah pertama adalah membuat penjadwalan ulang 

sesuai dengan Kurva S rencana pada Ms.Project kemudian menginput resource pada 

masing-masing pekerjaan. 

 

 

 

 

 

 

 

 

 

Gambar 2.9 Resource Ms.Project 
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Gambar 2.11 Hasil input resource akan menampilkan kebutuhan biaya pada masing-

masing pekerjaan. 

Setelah semua resource pada masing-masing pekerjaan selanjutnya adalah 

melakukan Tracing. 

Tracking dilakukan dengan bantuan program Microsoft Project dengan cara sebagai 

berikut : 

1. Pertama buka penjadwalan hasil simulasi di Microsoft Project 

2. Pilih menu Format > Insert New Colum 

3. Pada kolom baru pilih “% complete” 

4. Selanjutnya pilih menu Project > Project Information, selanjutnya pada kolom 

current date ganti tanggal dengan minggu berikutnya. Dan untuk minggu 

setelahnya ulangi proses ini untuk minggu-minggu berikutnya 

5. Setelah itu masukkan progres untuk setiap pekerjaan pada minggu tersebut yang 

sedang dianalisis. 

6. Selanjutnya pada menu Project > Update Project > pilih reschedule uncompleted 

work to start after > ok 

7. Maka program Microsoft Project akan melakukan tracking dan akan melakukan 

reschedule. Apabila terjadi keterlambatan pada kegiatan yang kritis, maka akan 

berpengaruh kepada bertambahnya durasi total dan biaya proyek. Berikut contoh  

kegiatan simulasi tracking:  
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Dengan proses tracking bisa diprediksi total durasi keterlambatan. Jika suatu 

pekerjaan misalkan pekerjaan C terlambat dari jadwal yang sudah direncanakan,maka akan 

terlihat akibat dari keterlambatan tersebut mengakibatkan bertambahnya durasi pekerjaan 

dan biaya tambahan akibat keterlambatan. 

 

 

        

 

Gambar 2.12 Tracking pada minggu ke 1 progress pekerjaan A mencapai 50% dan 

pekerjaan B mencapai 60%. 

 

 

        

  

 

Gambar 2.13 Tracking Pada minggu ke 2 progress pekerjaan A mencapai 100%, 

pekerjaan B mencapai 75% dan pekerjaan C belum dilaksanakan. 

Total Durasi dari 33 hari berubah menjadi 36 hari atau terlambat 3 hari akibat 

keterlambatan pelaksanaan Pekerjaan B. Jadi Pekerjaan B yang pelaksanaannya sampai 

dengan minggu ke 2 masih 75% diprediksi akan terlambat 3 hari sehingga durasi Pekerjaan 

B dari 12 hari menjadi 15 hari. Biaya Pekerjaan B semula Rp 60 juta bertambah menjadi 

Rp 63.480.000. 

 


